Course Syllabus Template
Revised: August 13, 2018
Instructions for using this Course Syllabus Template
What you need to know to get started
· Save this document to your computer.
Under the File menu, select Properties.
a. Change Author to your Name.
b. Change Title to your Course Title.  (Remember to change the course title for each new course.)
c. Don’t forget to rename and save the document to something more appropriate for each course.
· The syllabus is broken into discrete sections, which can be rearranged, removed, or modified to best fit your course and teaching style. 
· This syllabus template has been created using a style sheet in Microsoft Word. To maintain the accessibility of this document, delete text as necessary and fill in your own, but preserve the formatting as best you can. Please do not adjust the heading styles in this document. Styles have been set to make the document consistent and accessible for screen readers.
· Note: The department name is set as the Title style, Major Section headings are set as Heading 1, subheadings are set as Heading 2, and if needed, Heading 3 can be used for additional subheadings below Heading 2, Table Headers are set at Bold, and Normal is used for all other text. 
Adjust descriptions of activities and outcomes to fit your course
· Look for purple text used as a placeholder, to indicate information needed, text you should change, or (notes). Be sure to delete these (notes) before finalizing your syllabus and change the style to normal, unless otherwise indicated, which will change your text color to black. 
· Be sure to remove references to tools, activities, or sections that you do not plan to use in your course.
· The syllabus includes some common language to describe campus policies and services. Course Policies in black are required by the university and must be included in the syllabus as written. There are also some common Grading and Course Policy holders that you can use to add your own policies.
· All tables in this document are preformatted with Header Rows and include ALT text descriptions. Please do not remove them and be sure to set Header Rows and ALT Text in any tables you may add.
· If you wish to use colored text in your electronic syllabus, do not use red or green to convey important information because of the high incidence of color blindness related to these two colors.
· If you are including images in your syllabus, you will need to include an ALT text description for each. If it is just a decorative image, you can include double quotes, “”, in the ALT text box. 
· Remember to use descriptive links for hyperlinks instead of writing out the full URL inside of your document, especially for long URLs. Here are two examples
a. Bad Link: http://www.ut.edu/uploadedFiles/Academics/Provost/Title%20IX.pdf 
b. Good Link: Title IX PDF
To add a link
1. Highlight the text that you want to hyperlink
2. Right-mouse click and choose Link > Insert Link.
3. For Address, type or paste in the URL (beginning with http)
4. Click O.K.
You can still keep the URL, especially for documents which someone may want to print; however, place it in a footnote by using the References tab. To add the footnote
1. Click on the References tab.
2. Click on Insert Footnote
3. Type or Paste the URL (beginning with http) after the corresponding Footnote number.
· The document in its current form is accessible. You can either directly input your or copy and paste information from your previous syllabus.
· Directions for direct input
a. Highlight the corresponding text that you want to replace and type over it.
b. Finally, select the appropriate Style to change the color to black
· Directions for copying and pasting 
a. From your previous syllabus, copy the text that you want to transfer. This works best if you copy one paragraph, heading or list at a time. Copying and pasting more than this may result in loss of accessible formatting.
b. In the template, highlight the corresponding text that you want to replace and Right click the highlighted text in the new template and choose the Merge Formatting option.
c. Finally, select the appropriate Style to change the color to black.
· Always run the accessibility checker should after editing.
Delete these first two pages from your finished syllabus before distribution.

[image: ]
Department Name
Course Name
Insert Course Number and Section Insert Semester & Year Syllabus 
Course Information
Building and room: Insert Building and room number
Meeting days and times: Insert Day(s) and time
Number of credit hours in course: Insert Credit hours


Instructor Information
Instructor: Insert name, Title, and discipline e.g., Adjunct Instructor of Religion
Office: 
 Insert location here
Email: Insert UT Email 
Office Phone: Insert phone number
Office hours: Insert office hours by days and times

Course Description
Insert your course description here.
Required Texts/Materials
· Insert required textbooks here. Include detail such as full name of textbook, author, edition, ISBN, description (if desired), and where it can be purchased. If a required text is available online, indicate where it can be accessed.
· Insert additional materials here
Course Objectives
Upon completion of this course, students will be able to:
· Insert course objectives here. Speak directly to the student.
· Insert course objectives here. Speak directly to the student.
· Insert course objectives here. Speak directly to the student.
· Insert course objectives here. Speak directly to the student.


Grading Policy
Graded Course Activities
(Depending on how you will be grading your students throughout the semester, choose one of the tables below and delete the other. You can add or remove rows as needed.)
The table below describes the graded course activities including a description and the points for each. The first column includes a description of the activity and the second column includes the points for each.
	Activities
	Points

	Exam 1
	Example: 50 points

	Exam 2
	Example: 50 points

	Homework
	Example: 50 points

	Term Paper
	Example: 150 points

	Weekly Blogs
	Example: 50 points

	Final Exam
	Example: 100 points

	Class Participation
	Example: 20 points

	Total Points Possible
	Example 470 points


or 
The table below describes the graded activity categories and the percentage toward your final grade for each. The first column includes a description of the category and the second included the percentage toward your final grade for each.
	Activities
	Percentage	

	Exams
	Example: 20 %

	Homework
	Example: 20 %

	Term Papers
	Example: 30 %

	Final Exam
	Example: 20 %

	Class Participation
	Example: 10 %


Grade Distribution
This table contains the breakdown of how letter grades will be assigned for the course. The first column describes the letter grade. The second column describes the percentage associated with that letter grade.
	Letter Grade
	Grading Percentage
	UT Standard

	A
	above 92.5 %
	Outstanding

	AB
	above 87.5 % to 92.5 %
	Excellent

	B
	above 82.5% to 87.5%
	Very Good

	BC
	above 77.5 % to 82.5 %
	Good

	C
	above 72.5 % to 77.5 %
	Average

	CD
	above 67.5 & to 72.5 %
	Below Average

	D
	above 62.50 % to 67.5 %
	Passing

	F
	62.50 % or below
	Failing


Late Work Policy
Insert Policy Here
Viewing Grades
Insert Policy Here
Grade Appeals
Insert Policy Here


Course Policies
(Policies in Purple are optional and at the professor’s discretion. You may add additional policies as needed. Be sure to set the section heading for Heading 2 and Body Text as Normal.)
Participation/Attendance
Insert Policy Here
Recording Policy
Insert Policy Here
Computer and Electronic Media Policy
Insert Policy Here
(The following three disclosures are required to be included in your syllabus as written.  Delete this note before copying to your syllabus.)
[bookmark: Reporting_Sexual_Violence/_Title_IX_Matt]Reporting Sexual Violence/ Title IX Matters
 Sexual violence includes nonconsensual sexual contact and nonconsensual sexual intercourse (which is any type of sexual contact without your explicit consent, including rape), dating violence, sexual harassment, sexual exploitation, domestic violence, and stalking. You may reach out for confidential help (see contact info below) or report an incident for investigation.
If you choose to write or speak about an incident of sexual violence and disclose that this violence occurred while you were a UT student, the instructor is obligated to report the incident to the Title IX Deputy Coordinator for Students.  The purpose of this report is to provide a safe and nondiscriminatory environment for all students. The Deputy Coordinator or his or her designee will contact you to let you know about the resources, accommodations, and support services at UT and possibilities for holding the perpetrator accountable. If you do not want the Title IX Coordinator notified, instead of disclosing this information to your instructor, you can speak confidentially with the individuals listed below.  They can connect you with support services and discuss options for holding the perpetrator accountable.
There is an exception to this required reporting for preventative education programs and public awareness events or forums. While the instructor is not required to report disclosures during these instances, unless you make or initiate a complaint, during these programs or events, the instructor or another University official will ensure that the students are aware of the available resources at UT, such as counseling, health, and mental health services, and it will provide information about Title IX, how to file a Title IX complaint, how to make a confidential report, and the procedure for reporting sexual violence.
For more information, see The University of Tampa’s Title IX [footnoteRef:1] webpage and the Student Services Title IX and Sexual Misconduct Procedures[footnoteRef:2] webpage. [1:  http://www.ut.edu/titleix/]  [2:  https://www.ut.edu/studentconduct/titleix/] 

To make a confidential report of sexual violence, please contact:
· The Victim’s Advocacy Hotline: (victimadvocacy@ut.edu)  (813) 257-3900.
· Dickey Health & Wellness Center (wellness@ut.edu) (813) 257-1877.
· Health and Counseling Center (healthcenter@ut.edu) (813) 253-6250
[bookmark: ADA_Statement]ADA Statement
Students with disabilities: If there is a student who requires accommodations because of any disability, please go to the Academic Success Center in North Walker Hall for information regarding registering as a student with a disability. You may also call (813) 257- 5757 or email disability.services@ut.edu. Please feel free to discuss this issue with me, in private, if you need more information.
[bookmark: Academic_Integrity_Statement]Campus Closure Statement
Course interruption due to adverse conditions: In case of any adverse condition or situation which could interrupt the schedule of classes, each student is asked to access UT Homepage[footnoteRef:3] for information about the status of the campus and class meetings. In addition, please refer to UT Blackboard[footnoteRef:4] for announcements and other important information. You are responsible for accessing this information. [3:  http://ut.edu]  [4:  https://utampa.okta.com] 

(The following are highly recommended to be included in your syllabus. Delete this note before distributing to your students.)
Academic Integrity Statement
Academic integrity: Cheating, plagiarism, copying and any other behavior that is contrary to University standards of behavior will not be tolerated.
Students caught violating any aspect of the University of Tampa’s Academic Integrity Policy will be penalized in all cases. Penalty ranges from “0” on an assignment to “F” for the course without regard to a student’s accumulated points. Students may also face expulsion. It is the student’s responsibility to become familiar with the policies of the university regarding academic integrity and to avoid violating such policies. Policy information is found at Academic Integrity Policy[footnoteRef:5]. [5:  http://ut.smartcatalogiq.com/en/current/catalog/Academic-Policies-and-Procedures/Academic-Integrity-Policy] 

[bookmark: Class_Disruption_Statement]Class Disruption Statement
Disruption policy: Every student has the right to a comfortable learning environment where the open and honest exchange of ideas may freely occur. Each student is expected to do his or her part to ensure that the classroom (and anywhere else the class may meet) remains conducive to learning. This includes respectful and courteous treatment of all in the classroom. According to the terms of the University of Tampa Disruption Policy, the professor will take immediate action when inappropriate behavior occurs. Details of the policy may be found at Disruption of the Academic Process[footnoteRef:6]. [6:  http://ut.smartcatalogiq.com/en/current/catalog/Academic-Policies-and-Procedures/Disruption-of-the-Academic-Process] 

[bookmark: Campus_Closure_Statement][bookmark: General_Disclaimer]General Disclaimer
Note: The professor reserves the right to make changes to this syllabus as necessary.
.
 

Tentative Course Schedule
(Insert a brief explanation here of the table.)
	Week
	Date
	Topic, Readings, Assignments, Deadlines

	Week 1
	Date
	Insert 

	
	Date
	Insert 

	Week 2
	Date
	Insert 

	
	Date
	Insert 

	Week 3
	Date
	Insert 

	
	Date
	Insert 

	Week 4
	Date
	Insert 

	
	Date
	Insert 

	Week 5
	Date
	Insert 

	
	Date
	Insert 

	Week 6
	Date
	Insert 

	
	Date
	Insert 

	Week 7
	Date
	Insert 

	
	Date
	Insert 

	Week 8
	Date
	Insert 

	
	Date
	Insert 

	Week 9
	Date
	Insert 

	
	Date
	Insert 

	Week 10
	Date
	Insert 

	
	Date
	Insert 

	Week 11
	Date
	Insert 

	
	Date
	Insert 

	Week 12
	Date
	Insert 

	
	Date
	Insert 

	Week 13
	Date
	Insert

	
	Date
	Insert

	Week 14
	Date
	Insert

	
	Date
	Insert

	Week 1
	Date
	Insert

	
	Date
	Insert

	Week 16
	Date
	Final/Exam Time




Course Assignments
(Insert a brief explanation here of the table.)
	Due Date
	Assignment
	Short Description 
	Weight

	Insert
	Insert
	Insert
	Insert

	Insert
	Insert
	Insert
	Insert

	Insert
	Insert
	Insert
	Insert

	Insert
	Insert
	Insert
	Insert

	Insert
	Insert
	Insert
	Insert
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